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STD: XII                  LESSON 1 TO 10   MARKS: 70 

SUB: COMPUTER SCIENCE      TIME: 2.30 MINS 

QUARTERLY MODEL QUESTION PAPER – 1 

PART – I 

I. CHOOSE THE CORRECT ANSWER:                       15*1=15 

1. Which of the following is a distinct syntactic block?  

a) Subroutines   b) Function    c) Definition    d) Modules  

2. A sequence of immutable objects is called __________ 

a) Built in    b) List     c) Tuple    d) Derived data  

3. Which of the following security technique that regulates who can use resources in a computing 

environment?  

a) Password   b) Authentication  c) Access control   d) Certification  

4. __________ is more specific to a programming language  

a) Array   b) Structure   c) Algorithm   d) Program 

5. Time complexity of bubble sort in best case is __________. 

a) θ (n)    b) θ (nlogn)    c) θ (n2)    d) θ (n(logn) 2) 

6. Who developed Python?  

a) Ritche    b) Guido Van Rossum  c) Bill Gates    d) Sunder Pitchai  

7. How many important control structures are there in Python?  

a) 3    b) 4     c) 5     d) 6  

8. __________ Statement is generally used as a placeholder 

a) Pass   b) Break   c) Continue   d) Jump 

9. The named blocks of code that are designed to do one specific job is called as __________. 

a) Loop    b) Branching    c) Function    d) Block  

10. __________ provides better modularity for your application. 

a) Arguments  b) Parameters   c) Function   d) All the above 

11. Defining strings within triple quotes allows creating __________. 

a) Single line Strings  b) Multiline Strings   c) Double line Strings      d) Multiple Strings  

12. A list element or range of elements can be changed or altered by using simple __________. 

a) +   b) =    c) &    d) *  

13. What will be the result of the following Python code?  

S=[x**2 for x in range(5)] 

print(S)  

a) [0,1,2,4,5]   b) [0,1,4,9,16]   c) [0,1,4,9,16,25]   d) [1,4,9,16,25]  
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14. The keys in a Python dictionary is separated by a __________ 

a) . (dot)   b) , (comma)   c) : (colon)   d) ; (semicolon) 

15. Class members are accessed through __________ operator. 

a) &   b) .(dot)   c) #     d) %  

 

  PART – II 

II. ANSWER ANY 6 QUESTIONS: (Q.No.17 Compulsory)                                                6*2=12 

16. Define Subroutines 

17. What are Constructors and Selectors? 

18. Define Scope 

19. Define Tokens and its Classification? 

20. What is Anonymous Function or Lambda Function? 

21. Define the following Built – in String Functions: a) len()  b) capitalize()   

22. What are the Advantages of Function? 

23. Define Singleton Tuple 

24. Write the Syntax and Example for Class in Python? 

 

PART – III 

III. ANSWER ANY 6 QUESTIONS: (Q.No.33 Compulsory)               6*3=18 

25. What is the difference between Interface and Implementation? 

26. Define Mapping and Namespaces 

27. State Algorithm vs Program 

28. Define Break Statement 

29. What are the things that need to be noted when defining Functions? 

30. Define Stride when Slicing String Operator with Example 

31. What are the differences between Pure and Impure Function? 

32. Define the following list functions: a) index()  b) reverse()  c) sort() 

33. How to Access Class Member in Python? 

 

PART – IV 

IV. ANSWER THE FOLLOWING QUESTIONS:                5*5=25 

34. a) What are called Parameters and write a note on  

(i) Parameter without Type    (ii) Parameter with Type  

[OR] 
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b) Explain the types of scopes for variable? 

 

35. a) Discuss about Linear search algorithm.  

[OR] 

b) Explain the Characteristics of an Algorithm? 

 

36. a) Explain input() and print() functions with examples? 

[OR] 

b) Write a detail note on for loop. 

 

37. a) Write a Python code to find the L.C.M. of two numbers. 

[OR] 

b) Explain the different types of function arguments with an example? 

 

38. a) What the different ways to insert an element in a list. Explain with suitable example. 

[OR] 

b) Write a program to accept a string and print the number of uppercase, lowercase, vowels, consonants 

and spaces in the given string. 

 

// ALL THE BEST 
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STD: XII                  LESSON 1 TO 10   MARKS: 70 

SUB: COMPUTER SCIENCE      TIME: 2.30 MINS 

QUARTERLY MODEL QUESTION PAPER – 2 

PART – I 

I. CHOOSE THE CORRECT ANSWER:                15*1=15 

1. The small sections of code that are used to perform a particular task is called __________. 

a) Subroutines   b) Files    c) Pseudo code   d) Modules  

2. Which of the following functions that retrieve information from the data type?  

a) Constructors   b) Selectors    c) recursive    d)Nested  

3. Which of the following refers to the visibility of variables in one part of a program to another part of the 

same program? 

a) Scope    b) Memory    c) Address    d) Accessibility  

4. __________ of an algorithm is the amount of memory required to run to its completion. 

a) Space Complexity b) Time Complexity  c) Algorithm Strategy  d) Algorithm 

5. From the following sorting algorithms which algorithm needs the minimum number of swaps?  

a) Bubble sort   b) Quick sort    c) Merge sort    d) Selection sort  

6. __________ symbol is used to print more than one item on a single line.  

a) Semicolon(;)   b) Dollor($)    c) comma(,)    d) Colon(:)  

7. Which amongst this is not a jump statement?  

a) for    b) goto    c) continue    d) break  

8. While defining a function which of the following symbol is used? 

a) ; (semicolon)   b) . (dot)    c) : (colon)    d) $ (dollar) 

9. Python Interpreter will throw error for all __________ errors.  

a) Comments  b) Indentation   c) Condition   d) Elif 

10. Non-keyword variable arguments are called __________ 

a) List   b) Tuples   c) Pairs   d) Classes 

11. Which of the following formatting character is used to print exponential notation in upper case?  

a) %e    b) %E     c) %g     d) %n  

12. __________ statement is used to delete known elements 

a) remove( )   b) pop( )   c) clear( )    d) del 

13. Creating a Tuple with one element is called __________ tuple 

a) Singleton  b) Multiple   c) Tuple Assignment d) List Comprehension 

14. Which of the following function is used to count the number of elements in a list?  

a) count()    b) find()    c)len()     d) index()  
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15. Functions defined inside a class __________ 

a) Functions   b) Module    c) Methods    d) section  

 

PART – II 

II. ANSWER ANY 6 QUESTIONS: (Q.No.18 Compulsory)                                                6*2=12 

16. Define Function with respect to Programming Language 

17. Define ADT 

18. What is meant by Modular Programming? 

19. What is meant by Algorithm Strategy? 

20. What are Comments and Indentation in Python? 

21. Define If – Else Statement and Write the Syntax? 

22. Write the Syntax for User – Defined Function with example? 

23. Write the General format of replace ( ) function with example? 

24. Define Instantiation 

 

PART – III 

III. ANSWER ANY 6 QUESTIONS: (Q.No.32 Compulsory)               6*3=18 

25. What are the Characteristics of Interface? 

26. Define the following terms: a) Tuple  b) Instance  c) Pair 

27. List some benefits of using Modular Programming? 

28. What are the two components of Space Complexity? 

29. Define Memoization 

30. Define Block and Nested Block? 

31. Define Return Statement 

32. Define the following Built – in String Functions: a) isalnum() b) isalpha() c) isdigit() 

33. Write a python program that creates a list of numbers from 1 to 20 that are divisible by 2 

 

PART – IV 

IV. ANSWER THE FOLLOWING QUESTIONS:                5*5=25 

34. a) Explain with example Pure and impure functions.   

[OR] 

b) What is a List? Why List can be called as Pairs. Explain with suitable example? 
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35. a) Explain the Bubble sort algorithm with example.  

[OR] 

b) Explain the Following Operators with Example: 

i) Arithmetic   ii) Relational   iii) Logical  iv) Conditional 

 

36. a) Explain the While Loop with Example? 

[OR] 

b) Explain the scope of variables with an example.  

 

37. a) Explain about string operators in python with suitable example. 

[OR] 

b) What is the purpose of range( )? Explain with an example. 

 

38. a) What is nested tuple? Explain with an example. 

[OR] 

b) Write any Five Characteristics of Modules. 

 

// ALL THE BEST 
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STD: XII                  LESSON 1 TO 10   MARKS: 70 

SUB: COMPUTER SCIENCE      TIME: 2.30 MINS 

QUARTERLY MODEL QUESTION PAPER – 3 

PART – I 

I. CHOOSE THE CORRECT ANSWER:                15*1=15 

1. The values which are passed to a function definition are called  

a) Arguments   b) Subroutines   c) Function    d) Definition  

2. Which of the following is a compound structure?  

a) Pair    b) Triplet    c) single    d) quadrat 

3. Which of the following is used in programming languages to map the variable and object?  

a) ::    b) :=     c) =     d) ==  

4. __________ is used to describe the lower bound (best-case). 

a) Big O   b) Big Omega   c) Big P   d) Big Theta 

5. In dynamic programming, the technique of storing the previously calculated values is called?  

a) Saving value property  b) Storing value property  c) Memoization   d) Mapping 

6. The Python prompt indicates that Interpreter is ready to accept instruction.  

a) >>>   b) <<<    c) #     d) << 

7. The Command used to save the script in Python is __________ 

a) Edit→Save  b) File→Save   c) File→Saveas  d) View→Save 

8. What plays a vital role in Python programming?  

a) Statements   b) Control    c) Structure    d) Indentation  

9. __________ Statement unlike the break statement is used to skip the remaining part of a loop and start 

with next iteration. 

a) Pass   b) Break   c) Continue   d) Jump 

10. Which of the following keyword is used to define the function testpython():?  

a) define    b) pass    c) def     d) while 

11. __________are named blocks of code that are designed to do specific job. 

a) Arguments  b) Parameters   c) Function   d) All the above 

12. Which of the following is the slicing operator?  

a) { }    b) [ ]     c) <>    d) ( )  

13. __________ returns the index value of the first recurring element 

a) count( )    b) copy( )   c) index( )   d) reverse( )  

14. The keys in Python, dictionary is specified by  

a) =    b) ;     c)+     d) : 
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15. Which of the following method is automatically executed when an object is created?  

a) __object__( )  b) __del__( )    c) __func__( )    d) __init__( )  

 

PART – II 

II. ANSWER ANY 6 QUESTIONS: (Q.No.18 Compulsory)                                                6*2=12 

16. Define Recursive Function 

17. Define Abstraction 

18. What is meant by Algorithm Strategy? 

19. What are Escape Sequences with Example? 

20. Write the Syntax with example for If – Else? 

21. What is Composition in Functions? 

22. Write the General format of replace( ) function with example? 

23. Define Reverse Indexing 

24. Define the following list functions:  a) copy()  b) count() 

 

PART – III 

III. ANSWER ANY 6 QUESTIONS: (Q.No.30 Compulsory)               6*3=18 

25. What is meant by Function Specification? 

26. What are the different ways to access the elements of a list?  Give example? 

27. How python represents the private and protected access specifiers? 

28. State Algorithm vs Program 

29. What are the Key Features of Python? 

30. List the differences between break and continue statement? 

31. How to pass the parameters in Functions? 

32. Define format() Function with Example 

33. What are the Advantages of Tuples over List? 

34. Define Dictionary Comprehension 

 

PART – IV 

IV. ANSWER THE FOLLOWING QUESTIONS:                5*5=25 

35. a) Explain with an example interface and implementation. 

[OR] 

b) How will you facilitate data abstraction? Explain it with suitable example  
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36. a) Write any five benefits in using modular programming. 

[OR] 

b) What is Binary search? Discuss with example.  

 

37. a) Explain the concept of Dynamic programming with suitable example. 

[OR] 

b) Describe in detail the procedure Script mode programming.  

 

38. a) Write a detail note on if..else..elif statement with suitable example.  

[OR] 

b) Explain the following built-in functions.  

(i) id()    (ii) chr()   (iii) round()   (iv) type()   (v) pow()  

 

39. a) Explain the different set operations supported by python with suitable example. 

[OR] 

b) Write a program to accept a string and print the number of uppercase, lowercase, vowels, consonants 

and spaces in the given string. 

 

// ALL THE BEST 
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